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Introduction 

Probe Image Description 

 

 

Probe Image is a multi-platform, network interface imaging application for JEOL 
8900, 8200, 8500 and Cameca SX100, and SXFive electron microprobe analyzers. It 
can acquire  electron images (analog signals, e.g. SE, BSE, CL, etc.), EDS (ROI 
pulse outputs) and x-ray maps (WDS Spectrometer PHA pulse signals) in real time 
connected to the instrument simultaneously with other applications running 
concurrently and perform simple to advanced imaging processing both on-line and 
off-line. 
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Installation and Update of Probe Image 
To install Probe Image, open the supplied ZIP archive and run ProbeImage.msi. The 
recommended location is C:\Program Files\Probe Software\Probe Image for 32-bit 
operating systems and C:\Program Files (x86)\Probe Software\Probe Image for 64-
bit systems.  

 

If the Windows Firewall is active on the internal instrument network(s), a firewall 
exception should be added for Probe Image. For example for Windows 7, select 
Windows Firewall under System and Security in the Windows Control Panel, and 
click on “Allow a program or feature through Windows Firewall”: 
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In the next window, click “Allow another program…”: 
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Select Probe Image from the list and click “Add”: 

 

After installation, Probe Image should be run for the first time as administrator by 
right-clicking on the Probe Image program icon and selecting “Run as 
administrator”, no matter if the user account is already an administrator level account 
or not: 

 

This is only required for initial setup. Probe Image should run without problems 
using normal user credentials afterwards. 

You will need to go to the Setup | Probe Image Setup menu to specify your 
instrument interface type, stage and spectrometer limits and other instrument specific 
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settings. See the Setup | Probe Image Setup menu for more details on the specific 
configuration settings for Probe Image. 

To update Probe Image to the latest version, open the update ZIP archive, run 
ProbeImage.msi and specify the location of your existing installation. The existing 
files will be replaced by the installer as required. 

Downloading Software and Updates 
The Probe Image installer can be downloaded from 
http://www.probesoftware.com/Update.htm. Please contact Probe Software if you 
require a login and password. 
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Probe Image Operation  

Probe Image Main Window 
The default layout of the main window of Probe Image consists of the menu bar, a 
range of toolbars and panels, and the workspace in the center to display the images. 
The default layout can be restored by selecting the View | Reset All menu item. 

 

Menu Bar 
The menu bar contains the File, Edit, Basic, Advanced, Acquire, Setup, View, 
Window, and Help menus. They are discussed in detail in the Probe Image Menus 
section. Some menus are only available when images are open. 

Toolbars 
Probe Image features five toolbars: Standard, Basic, Advanced, Zoom, and Drawing. 
They are discussed in detail in the Probe Image Toolbars section. 
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Panels 
Probe Image uses four panels to display various types of information: Histogram, 
Event Log, Instrument, and Navigation. They are explained in detail in the Probe 
Image Panels section. 

Image Windows 
Multiple image windows can be open in the Probe Image workspace at the same 
time. Each image window contains four tabs: Image, Info, Conditions, and Notes. 
They are discussed in the Image Windows Contents section. 

 

Probe Image Toolbars 
Probe Image features five toolbars: Standard, Basic, Advanced, Zoom, and Drawing. 

A single click on a toolbar item activates its function. When hovering the mouse over 
a toolbar item, a short description of its function (tool tip) will be displayed next to 
the mouse pointer. 

To change the position of a toolbar, click on the dots on the left hand side or top of a 
toolbar (the mouse pointer changes into a four-way arrow) and drag it into the 
desired position. Toolbars can be floating anywhere on the desktop or be pinned to a 
specific position at any side of the Probe Image main window. 

Individual toolbars can be switched on and off in the View menu. To reset the 
toolbar positions to the default layout, select the View | Reset All menu item. 

Standard Toolbar 
The Standard Toolbar provides access to many features of the File and Edit menus 
and help. 

 

The following items are available from left to right: 

File New, Open, Save, Save All, Select Save To Folder | Cut, Copy, Paste | Print, 
Print Preview | Help 

Basic Toolbar 
The Standard Toolbar provides access to common image processing features of the 
Basic menu. 

 

The following tools are available from left to right: 

Duplicate, Crop | Rotate 90° CW, CCW, Rotate 180°, Flip Horizontal, Flip Vertical | 
Image Registration 
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Advanced Toolbar 
The Advanced Toolbar provides access to further image processing features of the 
Advanced menu. 

 

The following tools are available from left to right: 

Formula, Convolution, Filter, Re-size | Histogram 1D 

Zoom Toolbar 
The Zoom Toolbar provides access to some items of the View menu. 

 

The following tools are available from left to right: 

Zoom In, Zoom Out, Zoom 100%, Fit To Window  

Drawing Toolbar 
The Drawing Toolbar provides tools to select areas and lines in images (for copying 
or modification) and to annotate images. The currently selected tool defines the 
behavior of the mouse when left-clicking into an image. The tools can also be 
selected in the Advanced | Annotation menu. 

Drawing object parameters such as label text, color, shape, and size can be changed 
prior to drawing the object in the Drawing Objects section of the Setup | Probe Image 
Setup menu. 

The Drawing Toolbar can be hidden by clicking on the cross in the top right corner 
of the toolbar when in floating mode (see Probe Image Toolbars section for toolbar 
behavior). It can be restored by selecting the View | Reset All menu item. 
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The following tools are available from top to bottom: 

Move a drawing object 

Left-click on and move an existing drawing object in an image 

Select an image area 

Left-click and drag to select a rectangular area in an image. This area can then be 
copied to the system clipboard, the image can be cropped, the Basic | Crop to new 
function can be used to create a new image from the selection, etc. 

Select a line on the image 

Left-click and drag to select a line in an image. If this line is copied to the clipboard, 
the start and end points of the line will define the rectangular area to be copied. 

Place an arrow on the image 

Left-click and drag in an image to draw a new arrow using the label text, color, and 
size as pre-defined in the Drawing Objects | Arrow Defaults section of the Setup | 
Probe Image Setup menu. 

Place a line on the image 

Left-click and drag in an image to draw a new line using the label text, color, and 
size as pre-defined in the Drawing Objects | Line Defaults section of the Setup | 
Probe Image Setup menu. 

Place a marker on the image 

Left-click in an image to place a new marker using the label text, shape, color, and 
size as pre-defined in the Drawing Objects | Marker Defaults section of the Setup | 
Probe Image Setup menu. Available shapes are ×, +, and dot. 

Place a scale on the image 

Left-click in an image to add a scale bar using the label text, length, orientation, 
color, and size as pre-defined in the Drawing Objects | Scale Defaults section of the 
Setup | Probe Image Setup menu. 

Place a shape on the image 
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Left-click and drag to place a shape in an image using the label text, shape, color, 
and size as pre-defined in the Drawing Objects | Shape Defaults section of the Setup | 
Probe Image Setup menu. Available shapes are rectangle, rounded rectangle, and 
ellipse. 

Probe Image Panels 
Probe Image uses four panels to display various types of information: Histogram, 
Event, Instrument, and Navigation.  

To change the position of a panel, click on the title bar and drag it into the desired 
position. Panels can be floating anywhere on the desktop or be pinned to a specific 
position at any side of the Probe Image main window. 

Individual panels can be switched on and off in the View menu. To reset the panel 
positions to the default, select the View | Reset All menu item. 

Histogram Panel 
The Histogram Panel displays the histogram of an image, i.e. a graphical 
representation of the color or grey scale distribution within the image. 

To create a histogram for an image, use the Advanced  |  Histogram1D function. 

 

Event Log Panel 
The Event Log Panel displays Probe Image event messages. The log level can be set 
to normal or verbose in the Application | Log Settings section of the Setup | Probe 
Image Setup menu. The event log can also be exported to a file if enabled on the Log 
Settings page. 

 

Navigation Panel 
The Navigation Panel displays the live cursor information for the current image 
underneath the mouse cursor. There are several fields that are actively updated as the 
mouse is moved across the image: 

Pixel X,Y: pixel coordinate in zero based units. 

Zoom: current image zoom in %, relative to a 1:1 image/display pixel mapping 

Real X,Y,Z: actual stage coordinates of the pixel. Only available if the image is 
registered to real world coordinates (see Image Registration) 

Int: intensity of the pixel in data units. Analog units for analog signal images such as 
SE or BSE. Counts per second for WDS and EDS x-ray maps. 
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Color R,G,B: 24 bit color values for the RGB color components. R=G=B for grey 
scale images. 

 

Instrument Panel 
If Probe Image is installed on a PC connected to an instrument, the Instrument Panel 
displays the current stage X,Y,Z position and the spectrometer positions. It also 
displays if the Faraday cup is currently switched in or out. The units are native 
instruments units depending on the type of instrument. 

 

Image Window Contents 
Multiple image windows can be open in the Probe Image workspace at the same 
time. They can be moved by click and drag in the title bar and re-sized by click and 
drag on a window border or corner, which automatically adjusts the image zoom. 
They can be arranged using the functions in the Window menu. 

Each image window contains four tabs: Image, Info, Conditions, and Notes. 
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Image Tab 
The Image Tab displays the image data including modifications and annotations. 
Processing information such as false coloring is stored in the .PRBIMG file of the 
image. 

 

Info Tab 
The Info Tab displays the information as set prior to acquisition in the Basic Info 
section of the Setup | Probe Image Setup menu. This information is stored in the 
.PRBIMG file of the image. 
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Conditions Tab 
The Conditions Tab displays the image stage coordinates and acquisition conditions, 
if available. They are stored in the .PRBIMG file of the image. 

 

The exact contents of this tab depend on the signal type, i.e. if it is an analog video 
signal (VS) image such as SE, BSE, an EDS x-ray map, or a WDS x-ray map. The 
units depend somewhat on the type of instrument. 

Signal: input channel as set in the Setup | Acquisition window 

Baseline: WDS PHA baseline, usually in volts 

Window: WDS PHA window, usually in volts 

Gain: WDS detector gain 

Bias: WDS detector bias 

Mode: WDS PHA mode (integral or differential) 

Element: chemical element if x-ray map 

XRay Line: selected x-ray line (Ka = K, Mb = M, etc.) 

Crystal: WDS analyzing crystal 

Position: WD spectrometer position 

Offset: WD spectrometer position offset 

Deadtime: WDS detector dead time 

Angle: spectrometer take-off angle, in degrees. 

KeV: accelerating voltage in keV 

Current: beam current, usually in nA 

Pixel Time: dwell time per pixel, usually in microseconds 

Stage X1 / X2: left and right stage coordinates, respectively, usually in micrometers 

Stage Y1 / Y2: top and bottom stage coordinates, respectively, usually in 
micrometers 

Comment [K1]: Not 100% sure what this does 
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HFW: horizontal field width, i.e. the width of the image in micrometers 

VFW: vertical field width, i.e. the height of the image in micrometers 

Stage Z: Z axis coordinate of the stage 

Notes Tab 
The Notes Tab provides space to add individual notes for the image. The notes are 
stored in the .PRBIMG file of the image. 

Probe Image Setup 
Probe Image has to be set up correctly for your specific instrument type and 
configuration in the Instrument section of the Setup | Probe Image Setup menu.  

Additional global application settings are performed in the Basic Info, Application, 
and Drawing Objects sections. 

 

Probe Model 
The Probe Model defines the instrument type. For an off-line Probe Image 
installation this value is set to “Demo Microprobe”. 

 



Probe Image Refernce Manual v. 1.3.6 Probe Image Operation    15 

Probe Specific Settings 
The probe specific settings define the basic interface parameters. The contents of this 
window depend on the Probe Model setting. Two examples are given below for the 
Cameca SX100/SXFive and JEOL 8230/8530. Other instruments might have 
different settings. 

Cameca SX100/SXFive: 

 

IP Address: address of the microprobe itself, which is commonly a local address 
such as 192.168.0.1.  

Socket: 4000 for Cameca instruments.. 

Takeoff Angle: take-off angle of the x-ray spectrometers, 40 degrees.  

Image Display Size: define the stage to magnification conversion factor. It is only 
used by Cameca instruments and usually 38 cm.  

Spectros: specify the number of WD spectrometers. 

Newer SX100: refers to instrument generation. Ask your Probe Software support 
representative for the required setting for this item. 
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JEOL 8230/8530: 

 

Command and Notify IP Address: address of the microprobe itself, a local address 
such as 192.168.0.2.  

Command and Notify Socket: 22210 and 22200, respectively. Some older JEOL 
probes use socket address 2785. 

License Key: key code unique to particular instrument, 

Takeoff Angle: take-off angle of the x-ray spectrometers, 40 degrees.  

Spectros: specify the number of WD spectrometers. 
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Stage/Spectro Extents 
The stage and spectrometer limits are defined in native instrument units 
(micrometers and sin×105, respectively, for Cameca instruments and mm and 
L units for JEOL instruments). Normally the Flip Polarity flags are always 
unchecked for both Cameca and JEOL instruments. Two examples are given below 
for typical settings of Cameca SX100/SXFive and JEOL 8230/8530 instruments. 

 

Cameca SX100/SXFive: 
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JEOL 8230/8530: 

 

 

Beam Scan Calibration 
The Beam Scan calibration defines the stage to beam scan calibration for beam scan 
images. Multiple rows can be appended or inserted to optimise the calibration for the 
whole magnification range, for example on the Cameca SX100/SXFive: 
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Or on the JEOL 8230/8530: 

 

Basic Info 
The Basic Info fields allow the user to describe the instrument make and model and 
any other desired identification information.  

This information is included in all image acquisitions and saved to the .PRBIMG file 
for documentation purposes. 
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Application 
The Application section contains a large number of options that can be defined by 
the user. Most are self-explanatory but a few will benefit from some description. 

General Settings 

 

Image Defaults 

 

The “Use high quality resizing when zooming” option will perform a bi-cubic spline 
interpolation when a low resolution image is stretched by the user. 

Automation Settings 
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This dialog will specify whether the program will attempt to control the specified 
instrument functionality. “Allow crystal control” refers to changing WDS analyzing 
crystals, whereas “Allow spectrometer control” refers to changing of the 
spectrometer position. 

 

If the instrument functionality is unchecked the program will not attempt to perform 
that operation. 

Default Paths 

 

The Image Files section defines the default image path for saving and opening 
image files. If the user saves or opens a file from another folder, the new folder will 
automatically become the default image path. 

The Scan Acquisition Setup Files section defines the default path for opening and 
saving .PRBACQ acquisition files using the File | Open Acquisition and File | Save 
Acquisition menu items. 

The Probe for EPMA element file path is the location of the PROBEWIN.ELM file 
which Probe for EPMA updates whenever it moves a spectrometer to a new element 
position. This path has to be set correctly to enable the “Read ELM” function on the 
WDS Inputs tab of  the Setup | Acquisition menu. 

Log Settings 
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The Log Settings path and options are used for debug purposes. Normally these are 
turned off and no logging is saved to disk. 

Drawing Objects 
The Drawing Objects dialogs specify the settings for new drawing objects created 
using the tools in the Drawing Toolbar or the Advanced | Annotation menu. 

The parameters depend on the object type and commonly include label text, color, 
size, and shape. They can be adjusted as desired prior to creation of a new drawing 
object. 

 

Acquisition 
All acquisition and automation parameters are managed in the Setup | Acquisition 
menu. 

Acquisition settings can be saved and reloaded in the File | Save Acquisition and File 
| Open Acquisition menus, respectively. 

To start an automated acquisition, select Start in the Acquire menu. 

The Setup | Acquisition menu consists of several parts: 
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Acquisition Samples 

 

In this part of the Setup | Acquisition window, each sample configuration can be 
individually defined and saved to the Acquisition Samples list. 

Samples can be inserted before or after the selected sample by clicking the respective 
button. Selected samples can also be removed from the list by clicking Delete. This 
action only removes the sample from this acquisition list and does not modify any 
data already acquired. Samples can be renamed by clicking on the Sample Name. 

When the Acquire | Start menu is selected, the program will automatically acquire all 
acquisition samples in the list in order of appearance. 
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Sample Parameters 

 

In this part of the Setup | Acquisition window, one of three acquisition types can be 
selected:  

Beam: Data is acquired by scanning the beam without stage movement. The 
digitized XY stage position defines the center. In comparison, this setting provides 
the shortest acquisition times. But it can lead to intensity loss in x-ray maps due to 
defocussing of the spectrometers, especially if vertical WDS are used, where the 
Rowland circle geometry only allows little sideways movement without intensity 
loss. The area size limit for beam scans with WDS depends on the instrument, 
analyzing crystal, and crystal position (theta angle). It is usually in the order of a few 
tens of micrometers. 

Stage Ctr: Data is acquired with a fixed beam by moving the stage. The digitized 
XY stage position defines the center. This setting is commonly used with vertical 
WDS, unless the area is very small (see beam scan above). 

Stage 2Pt: 2 point stage scans defined by the two diagonal corners of the area to be 
scanned. 

Pixel time: Dwell time per pixel in milliseconds. 

Image Size: Image size in pixels (width × height).  

Enable Offpeak Positive: Enable acquisition of a WDS x-ray map in an off-peak 
position on the high side of the peak for background correction. As this map is 
acquired after the peak map, the dwell time per pixel is set separately. 

Enable Offpeak Negative: Enable acquisition of a WDS x-ray map in an off-peak 
position on the low side of the peak for background correction. Again this is a 
separate acquisition, so the dwell time per pixel is set separately. 

X, Y position: For Beam and Stage Ctr acquisition, XY stage coordinate for the 
image center. For Stage 2Pt acquisition, XY stage coordinate of a corner of the 
image 

Read X,Y: Set X and Y position values to current XY stage position of the 
instrument. 

X2, Y2 position: Stage 2Pt acquisition only. XY stage position of second (diagonal) 
corner of the image. 

Read X2,Y2: Stage 2Pt acquisition only. Set X2 and Y2 position values to current 
XY stage position of the instrument. 

Z position: Z stage position for the image. 

Read Z: Set Z position to current Z stage position of the instrument 

Magnification: Image magnification. 
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Read: Set magnification to current magnification on instrument. 

Pixel Size: Stage Ctr acquisition only. Size of the pixels in the image in micrometers 
(width × height). 

Scan Size: Absolute image size in micrometers (width × height). It is calculated 
from Image Size and Magnification for Beam acquisition, Image Size and Pixel Size 
for Stage Ctr acquisition, or the two diagonal X,Y coordinates for Stage 2Pt 
acquisition. Scan Size for Beam acquisition is only available if a Beam Scan 
Calibration has been performed in Setup | Probe Image Setup.  

Controls 

 

Read All: Set all values for X, Y, Z position, magnification, WD spectrometer 
position, and PHA to the current settings on the instrument. 

Move Ctr: Move the stage to the center of the image area currently set in Sample 
Parameters. 

Move UL: Move the stage to the upper left corner of the image area currently set in 
Sample Parameters. 

Move UR: Move the stage to the upper right corner of the image area currently set in 
Sample Parameters. 

Move LL: Move the stage to the lower left corner of the image area currently set in 
Sample Parameters. 

Move LR: Move the stage to the upper right corner of the image area currently set in 
Sample Parameters. 

Input Channels 
The inputs that can be selected are analog signals (SE, BSE, CL, etc.), WDS x-rays 
and EDS x-ray ROIs. The column conditions are also managed in this section. 

The parameters are managed on four different tabs in the lower part of the Setup | 
Acquisition window: WDS inputs, EDS inputs, Analog Inputs, and Column 
Conditions. 

WDS Inputs 
Up to five WDS channels can be present depending on the Probe Specific Settings in 
Probe Image Setup. They can be enabled individually. 

Comment [K2]: Check if reads PHA… as well? 

Comment [K3]: Check if works for stage 2Pt (i.e. 
if drives to calculated center instead of first corner) 
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Element: Clicking on the element button opens a periodic table to specify an 
element. Note this is for documentation purposes and does not automatically set any 
other spectrometer parameters. 

XRay Line: Select x-ray line (K, K, L, L, M, M, or absorption edge). 

Crystal: Select analyzing crystal. The contents of this drop down menu depend on 
the instrument configuration. 

Position: Spectrometer position (angle) in native instrument units 

+ Offset: Spectrometer position relative to the peak for the positive off-peak 
acquisition (see also Enable Offpeak Positive under Sample Parameters). 

– Offset: Spectrometer position relative to the peak for the negative off-peak 
acquisition (see also Enable Offpeak Negative under Sample Parameters). 

Baseline: Lower limit of PHA differential window, usually in volts. 

Window: Width of PHA differential window, usually in volts. 

Gain: Detector gain, instrument specific. 

Bias: Detector bias, instrument specific. 

Mode: PHA mode, integral or differential. 

Deadtime: Detector dead time, instrument specific. For Cameca instruments usually 
fixed to 3 microseconds. 

Read ELM: Read current element setting on the spectrometer as defined in the 
Probe for EPMA software. Only available if the Probe for EPMA element file path 
has been set correctly in the Default Paths section of the Setup | Probe Image Setup | 
Application menu. 

Read Inst.: Read current actual spectrometer position and PHA values off the 
instrument. 

EDS Inputs 
As the EDS integration utilizes the OEM EDS integration of the instrument, only the 
element and line are specified (e.g. Si Ka for Si K). Further parameters such as ROI 
position and width, background correction, etc. can potentially be adjusted in the 
EDS software depending on the actual system. 
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Up to four channels can be used on Cameca and up to 16 on JEOL instruments. 

 

Analog Inputs 
Analog signals to be acquired such as SE, BSE, or CL. The assignment of a detector 
signal to the respective VS channel is done in the instrument software. Note that 
JEOL analog signal images can be 8 or 16 bit but Cameca analog signal images can 
only be 8 bit. 

 

Column Conditions 

 

Use current instrument column settings: Use current instrument settings as they 
are, without attempting to change anything. 

High Voltage: Accelerating voltage in keV. The actual value can be read from the 
instrument using the Read button. 

Beam Size: Beam diameter on the sample surface in micrometers. A value of zero 
specifies no beam defocussing. The actual value can be read from the instrument 
using the Read button. 

Other parameters such as beam current can be set in the instrument software or in 
Probe For EPMA. 
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Quantitative Mapping 
Quantitative mapping involves 3 applications and will therefore be discussed in 3 
sections: 

1. Setup and acquisition of calibration standards in Probe For EPMA (PFE) 

2. Map acquisition in Probe Image 

3. Map quantification in CalcImage 

The screenshots were captured with the software in demo mode using a Cameca 
SX100 configuration. Some windows and parameters might look different depending 
on your instrument configuration (and software version). 

Setup and acquisition of calibration standards in 
Probe For EPMA 
The procedure is basically the same as for a point measurement run. First create a 
new project or open an existing project in PFE. Click on "Acquire!" to open the 
Acquire! window and click on "New Sample". In the New Sample dialog, select 
"Unknown", add the required standards to the run using the "Add/Remove 
Standards" button and type in a name. If available, you can also load existing 
"Element Setups" for individual elements from your Setup.MDB database, "Sample 
Setups" which you may have defined earlier in the project file, or "File Setups", i.e. 
setups from other project files.  

 

In this example we're loading a File Setup from a pyroxene run:  
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If the File Setup is linked to valid standard intensity measurements, they can be 
loaded as well. If the standards were acquired recently they might still be usable for 
map quantification, depending on instrument stability. 

 

When finished, click OK, open the Elements/Cations window and adjust the element 
list as desired. In this example two elements are specified per spectrometer. During 
mapping, only one element can be acquired per WDS at a time so in this case we'll 
have to do two passes to acquire maps for all elements. However, for quantification 
in CalcImage all maps will be combined and a single PFE sample setup will be used. 
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Now click on an element row to open its Element Properties window. Although it is 
possible to choose different settings for standards acquisition and map quantification, 
we'll use the same settings for both and will set up everything as intended for the 
mapping right now. An important consideration for quantitative mapping is the 
background correction. Conventionally it requires acquisition of separate off-peak 
maps which substantially increases overall map acquisition time. Probe Image can 
collect up to 2 off-peak maps per element. To save acquisition time, a single off-peak 
map per element with a predetermined slope factor could be used. All background 
correction options available for point measurements can also be used for map 
quantification (linear, exponential, slope...) except for Multi-Point.  
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In this example we use MAN (mean atomic number) background correction which 
offers a powerful alternative for quantitative mapping, as it doesn't require off-peak 
measurements and therefore can save considerable instrument time. It requires 
setting up MAN calibration curves using standard measurements which is described 
in more detail elsewhere. MAN is normally only used for major elements but has 
been shown to work down to concentrations of 0.01 wt% under certain 
circumstances which need to be established carefully. MAN could potentially even 
be used for trace element mapping in simple unchanging matrices (e.g. Ti in 
quartz...) in combination with a "blank" correction. 

When finished with all elements, close the Elements/Cations window, and adjust 
parameters like analytical conditions, count times, and other acquisition options for 
the standards acquisition as you normally would for a point measurement run. These 
parameters will be set separately for the map acquisition in Probe Image. If you 
select the "Return to On Peaks After Acquisition" flag in the Acquisition Options 
window, the first set of elements on the WDS will already be set correctly in the 
Probewin.ELM element file for quick import into Probe Image. 
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Open the Analyze! window and click "Standard Assignments" to check/adjust 
primary standard assignments. 

Open the Automate! window and digitize the standards. Select the "Peak 
Spectrometers" and "Peak on Assigned Standards" flags to perform an automated 
peaking as part of the standards acquisition if your instrument is set up to perform 
this reliably. Alternatively you can peak manually using the "Peaking Options" and 
"Start Peaking" buttons in the Acquire! window. 
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Select all standards to run and click "Run Selected Samples". After the standard 
acquisition is finished, check the results and delete any "bad" lines as you commonly 
would for a point acquisition run.  

If using MAN background correction, select Analytical | Assign MAN fits in the 
main PFE window and to check and optimize the MAN calibration curves. 
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Map acquisition in Probe Image 
Launch Probe Image. 

Go to File | Select Save To Folder... to set the path for saving the maps: 

 

Next, go to Setup | Acquisition: 

 

Name the first map in the Acquisition Samples section in the top left by clicking into 
the corresponding Sample Name field:  
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In the Sample Parameters section, select the map type, in this example a stage scan 
with the centre position and the size specified. An image size of 256x192 pixels and 
a pixel size of 1.0x1.0 microns gives an overall map size of 256x192 microns: 

 

Drive the stage to the centre of the desired map area and click "Read XY" and "Read 
Z" to import the stage coordinates: 

 

Set the Pixel Time to the desired dwell time per pixel. If input channels are enabled, 
the overall acquisition time will be dynamically updated: 
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If required, enable one or both off-peak map acquisitions and specify the respective 
pixel dwell times. In our example we'll leave both deselected as we're using MAN 
background correction: 

 

In the lower part of the window, tick the boxes to enable the WDS. Click the "Read 
ELM" buttons for each channel to import the parameters for the first 5 elements: 

 

For the Read ELM to work requires the correct path to Probewin.ELM to be 
specified in Probe Image under Setup | Probe Image Setup | Application | Default 
Paths | Probe for EPMA element file. 

EDS channels can be specified on the EDS Inputs tab if possible for the specific 
microprobe/EDS combination, for example in the case of a Cameca SX100/SXFive 
with the integrated Bruker EDS. Simultaneous acquisition of other images (SE, BSE, 
CL, as available) can be enabled on the Analog Inputs page.  
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Click the "Insert After" button in the Acquisition Samples section to create another 
map with the same settings: 

 

In PFE, create a new unknown sample and load the Sample Setup for the second five 
elements. Again go to Acquire! | Peaking Options and click "Move To On Peak (start 
analysis) Positions". Wait until the move is completed then click "Read ELM" again 
for the WDS channels in Probe Image: 

 

Finally, click OK in the bottom right corner to close the Scan Setup window. 

Set conditions (accelerating voltage, beam current, beam diameter) on the instrument 
as desired.  

To start the acquisition, select "Start" from the Acquire menu: 
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Probe Image now opens a new image window for every WDS, EDS, and electron 
image: 

 

To arrange the image windows next to each other, select for example "Tile 
Horizontally" from the Window menu: 
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The image windows are updated whenever a line acquisition is completed as shown 
here for the 5 elements in the first map acquisition: 

 

At the end of the multiple map acquisition, Probe Image will insert the Faraday cup.  

Save all images by selecting "Save All" in the File menu: 



40    Probe Image Operation Probe Image Refernce Manual v. 1.3.6 

 

The maps are now ready for quantification and further processing in CalcImage. 

Map quantification in CalcImage 
Launch CalcImage. This application is part of the Probe For EPMA package and 
should reside in the Probe Software/Probe For EPMA folder. 

Go to the Project menu and select "Create (new) Project Wizard!": 

 

The software displays step by step instructions how to build the new project: 

 

Click OK. An Open File dialog opens. Find and highlight the Probe for EPMA 
.MDB database that was created in the Part 1 of the tutorial when setting up the 
parameters for the map and click "Open": 
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The software loads the file and displays the instructions for the next step: 

 

Click OK. A window opens displaying all samples in the .MDB file. Select the 
"quant map setup" sample created in Part 1.  This sample contains all 10 elements to 
be quantified, as listed on the left hand side of the window. We will combine the two 
(or more) separate Probe Image map acquisitions (5 elements each, same area) into 
one dataset, so that all major elements are accounted for in the matrix correction. 
Click OK: 
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Again, the instructions for the next step are displayed: 

 

Click OK. Another Open File dialog opens. Select one of the .PRBIMG files for the 
first map acquision, for example Mg, and click "Open". (Note: do not select one of 
the electron image files which are VS1, VS2.) 
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The software will automatically load all x-ray element maps of that acquisition 
(including optional off-peak images if these were acquired) and create individual 
Golden Software Surfer .GRD image files. After that's done, the same window opens 
again. Now select one of the files for the second map acquisition, e.g. Na and click 
open: 

 

After completion, the same window opens again. As all required files have now been 
imported, click "Cancel" to stop the importing: 

 

All ten .GRD files are opened and arranged in the main CalcImage window: 
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A message box is displayed with suggestions for the next steps: 

 

Click OK. Select Project | Specify Quantitative Parameters!: 
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In this window, first check in the bottom half if the .GRD image files have been 
assigned correctly to the corresponding elements (including optional off-peak images 
if these have been acquired). Also, tick the boxes for "Calculate 'Totals' Image" and 
"Calculate Stoichiometric Oxygen Image". These are useful to assess the quality of 
the quantification: 

 

The "Calculation Options", "Elements/Cations", "Standard Assignments" and 
"Specified Concentrations" buttons are similar to Probe For EPMA and can be used 
to change the corresponding settings. Click for example "Calculation Options" to 
ensure oxygen is calculated by stoichiometry in the quantification. This is required as 
the mapped minerals all contain oxygen as the main anion and we did not acquire an 
oxygen map: 
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The Analysis | Analysis Options menu can also be used in a way very similar to 
Probe For EPMA to change global quantification options, for example to use 
aggregate intensities to combine maps of the same element acquired in parallel on 
more than one spectrometer. 

Next, select Project | Output Sample Parameters!: 

 

If no problems with the settings are found, the following message is displayed in the 
CalcImage Calculation window: 
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Select Project | Calculate Quantitative Images! to start the map quantification: 

 

A message box appears to double-check everything's ready to go: 
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Click OK. The quantification starts. Progress and estimated finish time are displayed 
at the bottom of the window: 

 

After completion, the following message box is displayed: 

 

Click OK. An additional ..._Quant.GRD file has been created in the same directory 
as the .MDB file for every element and in this case also ..._Oxygen_Quant.GRD and 
..._Total.GRD. The project information is stored in the .CIP file. The quantified 
images are displayed in CalcImage: 
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To display only the quantified images, select File | Close All Images: 

 

Then select Project | Open Images For Current Project | Open Quant (elemental) 
Images: 
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When moving the mouse pointer over the maps, the corresponding X and Y stage 
coordinates are displayed in the header of the respective image window. The 
concentration of the element is displayed as the Z value. 

In the Processing menu, CalcImage offers further processing capabilities to classify 
maps, for example to identify different phases and calculate their modal abundances. 

For presentation purposes and other operations (such as extracting slices from the 
maps or calculating average compositions), the maps are exported to Golden 
Software Surfer. Different output formats are available. For example, to simply 
export the quantified maps for presentation, select Project | Export the Project Grid 
Files For Presentation Output | Output Quant Maps To Surfer: 
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CalcImage then creates a Golden Software .BAS script file: 

 

Click OK. Another message box opens: 

 

Click Yes to run the .BAS file rightaway.  For this to work, Surfer must be installed 
on the PC and the location must be specified correctly in the Software section of 
Probewin.INI, e.g.: 

SurferAppDirectory="C:\Program Files\Golden Software\Surfer 11" 

This opens the applications Scripter and Surfer and performs the operations as 
specified in the .BAS file. In this case, three Surfer .SRF files and corresponding 
.JPG image files are created, each containing four maps arranged on one page. The 
first page as displayed in Surfer is shown below: 
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Probe Image Menus 

File 
The File menu provides functions to create, open, save, import, export, and print 
images. Some functions are only visible when image files are open. 

Many items of the File menu are also available in the Standard Toolbar. 

New 
Open a new image file from disk. You may select one of the common image sizes (in 
pixels) from the options or enter the desired width and height in pixels by hand. 

 

Open… 
Open an existing file from disk. Image format file types supported are: 

BMP, PNG, JPG, JPEG, JPE, TIF, TIFF, GIF, PNM, PPM, PGM, PBM, PCX, ICO, 
CUR, ANI, TGA, TPIC, and XPM.  

Note that JPG, JPEG and JPEG are all JPEG files. TIF and TIFF are both TIFF files. 
PNM, PPM, PGM, and PBM are all NetBPM portable map files.. 

If the image has a .PRBIMG file with the same name, the image acquisition 
parameters associated with that image will be automatically loaded as well. 

The .PRBIMG file contains additional information such as stage coordinates. 
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Close / Close All 
Close the currently selected image or all open images, respectively. The software 
will give the user an opportunity to save, not save or cancel the operation for each 
file.  

The default image save path is the Image File path defined in the Probe Image Setup 
dialog (Application | Default Paths) or the last folder utilized by the user in the 
current session. 

Save / Save All 
Save the currently selected image or all open images, respectively. If the image is a 
disk  file or has already been saved to a specific image format it will be saved in that 
format again.  

The supported image formats are are: BMP, PNG, JPG, JPEG, JPE, TIF, TIFF, GIF, 
PNM, PPM, PGM, PBM, PCX, ICO, CUR, ANI, TGA, TPIC, and XPM.  

Note that JPG, JPEG and JPEG are all JPEG files. TIF and TIFF are both TIFF files. 
PNM, PPM, PGM, and PBM are all NetBPM portable map files. 

Save As… 
Save the currently selected image in a specified image format from the list of 
supported formats above.  

Select Save To Folder… 
Specify the folder where to save the images.  
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Open Acquisition… 
Open an existing Probe Image acquisition file (.PRBACQ). .PRBACQ files contain 
all parameters set in the Setup | Acquisition menu. 

 

Save Acquisition… 
Save the current settings in the Setup | Acquisition menu to a Probe Image 
acquisition file (.PRBACQ). 

Import / Export File 
Import or export files in a third party image format. The only currently supported 
image format is a Surfer 7 grid file format from Golden Software (.GRD extension). 

Comment [K4]: Work out on SX what exactly is 
stored in .PRBACQ (Setup – acquisition) 

Comment [K5]: Work out on SX what exactly is 
stored in .PRBACQ (Setup – acquisition)
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The image will utilize the .GRD file coordinates for the “real world” image 
registration, e.g. the actual microprobe stage coordinates of the pixels in the image. 

 

Print 
Print the currently selected image to the default printer. 

Print Preview 
Print preview of the currently selected image using the default printer configuration. 

Print Setup 
Change the default printer or printer configuration. 

Exit 
Exit the Probe Image application. 

Edit 

Cut 
Not implemented at the time. 

Cut the current selection to the system clipboard. 

Copy 
Copy the currently selected area on an image to the system clipboard. 

Paste 
Not implemented at the time. 
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Paste the clipboard bitmap data to the currently selected image window. 

Basic 
Perform basic image processing on the selected image. Some of the menu items are 
also available in the Basic Toolbar. 

Duplicate 
Duplicate the currently selected image. 

Crop 
Crop the currently selected image based on the selected image area. 

Crop to new 
Create a new image from the selected image area. 

Statistics… 
Not implemented at the time. 

Calculate image statistics. 

Contrast Enhancement 
Perform various contrast enhancement operations on the currently selected image. 

Histogram Equalization 

Not implemented at the time. 

Normalize the image data to the number of histogram bins (e.g. 256 for 8-bit) in the 
image. 

Linear Stretch 

Perform linear contrast stretch of the image data. 

Brightness/Contrast 

Not implemented at the time. 

Manually adjust image brightness (value addition) and/or contrast (value 
multiplication) on the palette values. 

Palette Stretch 

Not implemented at the time. 

Stretch the image palette. 

False Color 
Perform false color manipulations on the image palette. The following false color 
look-up tables (LUTs) are available: Blue Red, Gray Scale, JEOL, Rainbow, 
Thermal. 

Comment [K6]: How does this work? 

Comment [K7]: How to select multiple images? 
Various key/mouse combinations don’t work on 
Airbook 

Comment [K8]: More details in individual items 
to make difference clear 

Comment [K9]: what's this? 
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Rotate/Flip Image 
Perform image rotation and axis flipping on the image data. 

Rotate 90 Degrees CW 

Rotate the image 90 degrees clockwise. 

Rotate 90 Degrees CCW 

Rotate the image 90 counter-clockwise. 

Rotate 180 Degrees 

Rotate the image 180 degrees. 

Flip Horizontal 

Flip the image about the horizontal axis. That is to say, flip the top and bottom of the 
image. 

Flip Vertical 
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Flip the image about the vertical axis. That is to say, flip the right and left of the 
image. 

Normalize 
Not implemented at the time. 

Normalize the image to the raw data range. 

Image Registration 
Edit the image “real world” registration parameters. That is to say, the pixel to stage 
mapping. 

 

The Image Registration can utilize a 3rd point for defining the sample tilt. 

Advanced 
Perform advanced image processing on the selected image. Some menu items are 
also available in the Advanced Toolbar. 

Modify Image 
Modify the image through operation designed to modify either the image data or 
palette. 

Comment [K10]: How to select multiple images? 
Various key/mouse combinations don’t work on 
Airbook 
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Make Mask 

Not implemented at the time. 

Create a binary image mask based on the selected pixel value. 

Mask Image 

Not implemented at the time. 

Using a selected image mask, apply the mask to the selected image data. 

Formula 

Not implemented at the time. 

Perform mathematical operations on the currently selected image using pre-defined 
or user specified algebraically defined formulas where the image data is represented 
by variables and the operations are using standard mathematical operators. 

Convolution 

Convolute the currently selected image data based on the selected filter coefficients 
and filter type. 

 

Filter 

Not implemented at the time. 

Perform a filter operation on the currently selected image. 

Re-size 

Re-size the currently selected image through duplication or sub-sampling of the pixel 
data. 
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Classify 
Not implemented at the time. 

Classify the image by correlating pixel values where each image represents a spectral 
band. 

Histogram 1D 
Calculate and display a one dimensional histogram for the currently selected image. 

Histogram 2D 
Not implemented at the time. 

Perform a number of two dimensional histograms, operations using two selected 
images. 

Calculate 

Calculate a two dimensional histogram. Selected images may be raw data or 
calculated quantitative data. 

Kill Single Pixel 

Remove a single pixel that is dominating the data set. 

Pixel Traceback 

Perform a pixel traceback whereby a user defined area in the two dimensional 
histogram space is traced back in X and Y space and displayed as a mask. 

Concatenate Images 
Perform various image concatenation operations. 

Mosaic 

Mosaic the images together based on their real world image registration. For 
example: 
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Pave 

Tile the selected image together into a single image. Images must be the same pixel 
size. For example: 

 

Combine 

Combine the selected images. 

Composite 
Not implemented at the time. 

Create and RGB composite image by specifying the red, green and blue images to be 
optimized as a single RGB image. 

Special Effects 
Perform various special effects on the image data. 

Erode 
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Erode object boundaries in images by setting the value of each pixel to the minimum 
value found in its neighborhood, i.e. the pixel itself and the 8 surrounding pixels. 

Dilate 

Dilate object boundaries in images by setting the value of each pixel to the maximum 
value found in its neighborhood, i.e. the pixel itself and the 8 surrounding pixels. 

Median 

Perform a median filter on the image to reduce noise. This is a smoothing filter 
which can negatively affect edge visibility. Median filtering sorts the values of a 
pixel and its 8 surrounding pixels in numerical order and then replaces the value of 
that pixel with the middle (fifth) value from that list.  

Negate Data 

Reverse the data values in the image. That is to say, create a negative of the image. 

Burn-In 
Not implemented at the time. 

Burn-in all drawing and annotation objects into the pixel data. Usually performed 
prior to exporting the image for publication. 

Annotation 
Perform various image annotation operations. These functions are also accessible 
through the Drawing Toolbar. 

Move Drawing Objects 

Move the selected drawing object. 

Select Area / Line 

Select an image area or line. 

Draw Arrow / Line / Marker / Scale / Shape 

Draw an arrow, line, marker, scale bar, or shape at a user specified location on the 
image.  

Parameters such as label text, size, shape, color, etc. can be set prior to drawing in 
the Setup | Probe Image Setup menu in the Drawing Objects section. 

Available shapes for the marker are cross, dot, and plus. Available shapes for Draw 
Shape are rectangle, rounded rectangle, and ellipse. 

Acquire 
Acquire analog signal images and/or  x-ray maps using beam and/or stage scanning 
based on the settings made in Setup | Acquisition. 
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Start 
Start image acquisition run as specified in the Acquisition Samples list in Setup | 
Acquisition. 

Halt/Reset 
Halt the current image or map acquisition immediately. 

Show Scan Line 
Toggle the acquisition progress line display (white line in images). 
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Configure Video 
Configure settings for acquisition of single video frames, commonly SE or BSE 
images. The contents of the window depend on the instrument type.  

Use Video size to specify the image resolution by setting the width of the image (in 
pixels. The height is automatically determined based on this selection.  

Video Speed provides presets for different scan speeds. 1 is the fastest scan speed 
available on a specific instrument for a certain resolution, e.g. 0.32 seconds frame 
time for 1024×768 pixels resolution on a Cameca SX100. Increasing numbers 
provide increasingly slower scan speeds, e.g. speed 2 = 0.64 seconds, speed 3 = 1.28 
seconds, speed 4 = 15.36 seconds etc. for the same resolution on the same 
instrument. 

. 

Video Frame 
Acquire a single video frame using the currently selected analog signal image 
channel. These menus depend on the instrument type.  

Cameca instruments will show: 

Acquire Frame VS1 

Acquire Frame VS2 

Acquire Frame VS1 and VS2 

JEOL instruments will show: 

Acquire Video Frame 

The JEOL demo probe does not show any Video Frame menu items. 

The assignments of detector signals to the respective VS channel is performed in the 
instrument software. 

Setup 
The setup menu contains two items:  

Acquisition 

Probe Image Setup  

Due to their complexity and importance they are both discussed in detail in separate 
sections under Probe Image Operation. 
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View 

Zoom In 
Zoom the currently selected image in (increase zoom). 

Zoom Out 
Zoom the currently selectedimage out (decrease zoom). 

Zoom 100% 
Zoom the currently selected image to a 1 to 1 image pixel to screen pixel mapping 
ratio. 

Fit To Window 
Fit the currently selected image to the size of the image window area. 

… Drawing Objects 
Set of individual menu items to show or hide display of arrow, line, marker, scale, 
and shape drawing objects. 

 

… Toolbar 
Set of individual menu items to show or hide display of the Standard, Basic, 
Advanced, and Zoom Toolbar.  

 

… Panel 
Set of individual menu items to show or hide display of the Histogram, Instrument, 
Event Log, and Navigation Panel.  
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Reset All 
Reset all menus, toolbars, and panels to the default layout. 

 

Window 

Cascade 
Cascade all image windows. 

Tile Horizontally 
Tile all image windows horizontally. 

Tile Vertically 
Tile all image windows vertically. 
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Arrange Icons 
Arrange all icons. 

Next 
Select the next image window. 

Previous 
Select the previous image window. 

Help 

Help… 
Open this help file. 

 

Visit Probe Software Online… 
Open your default browser and go to the Probe Software web site. 



Probe Image Refernce Manual v. 1.3.6 Probe Image Menus    69 

 

About 
About Probe Image. 
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Glossary of Terms 

Alpha Factor 
Early EPMA workers did not have the luxury of high speed computers, and the 
complex rigorous physics-based matrix corrections could not be easily performed in 
an applications-oriented probe lab. Alpha factors or coefficients  for matrix 
correction in binary compounds (e.g., Fe on Ni K, Ni on Fe K) were initially 
conceived of by Castaing in his 1951 Ph.D. dissertation. Ziebold and Ogilvie (1964) 
revisited alpha factors in the popular scientific literature as the development of 
commercial electron microprobes took off. Shortly thereafter, efforts to consider 
phases of more than 2 elements spurred the development of beta-factors. This was 
applied to geological EPMA by Bence and Albee (1968) who developed oxide alpha 
factors; this paper is one of the most frequently cited references in geology (over 
1800 citations between 1982-2001). Several decades later, it was recognized that the 
alpha-factor approach could be fine-tuned for improved quantitative results using 
additional fit coefficients (linear and polynomial) (Rivers, pers. comm., 1990, and 
Armstrong, 1991).  

These factors are derived by fitting concentrations vs. alpha-factors, from calculated 
or measured k-ratios in a system of binary standards covering a range of 
composition. See also beta-factors. The expression for the calculation of a single 
alpha-factor is shown below: 

 

Where: 

C: elemental weight fraction of the element 

K: calculated or measured k-ratio at that concentration 

 

The calculation of the matrix correction for an unknown sample is shown below: 

 

Where: 

: unknown beta-factor 
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: standard beta-factor 

Atomic Percent 
The atomic percent is calculated based of the fraction of the atomic weight of the 
element. Also called "elemental mole" percent. Since the calculation normalizes the 
data to a 100 % total, it is recommended that the calculation be only performed on 
samples which total close to 100 % (e.g., 98-102). The calculation is as follows : 

 

W: elemental weight percent of the element 

A: atomic weight of the element 

Average 
Also known as the mean or arithmetic mean. The average is calculated by simply 
dividing the sum by the number of values. The calculation is shown below. 

 

Where: 

X: values to be averaged 

n: number of values to be averaged 

Average Atomic Number 
Also known as Z-bar or Mean Atomic Number (MAN). The sum of the elemental 
weight or atomic fractions of the element atomic numbers of a sample.  

The sum of the weight fractions of the atomic numbers of a sample is applicable for 
modeling the background continuum and is used in the MAN background correction 
iterated polynomial calculation by Probe for EPMA to approximate the average Z-
bar (electron fractions are actually more rigorous).  

On the other hand, the sum of the atomic fractions of the atomic numbers of a sample 
is applicable to stopping power calculations and is used in Monte Carlo calculations 
of electron trajectories.  

The weight fraction calculation is quite simply: 

 

Where: 

Z: atomic number of the element 

W: elemental weight or atomic percent of the element 

A
X

n
i
n

i  1
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Beta Factor 
Beta-factors are the normalized sum of the weight fraction weighted alpha-factors for 
a given compound composition. These are utilized in the quantitative calculation of 
unknown compositions. See alpha-factor above. 

Bragg’s Law 
In 1913, the father-son team of William H. and William L. Bragg built an x-ray 
spectrometer, using NaCl to resolve Pt x-rays. For this they received the Nobel Prize 
in 1915. 

  

Where: 

n: order of the x-ray (1st, 2nd, etc.) 
: wavelength in angstroms 
2d: lattice spacing of the analyzing crystal in angstroms 
: angle of diffraction 

 

 

 

There is a more precise form of Bragg's Law that allows for refraction of x-rays by 
the analyzing crystal (a.k.a. monochromator, diffractor); this can be shown as a 
modification of the 2d such that d' = d[1-(k/n2)], where n is the order of reflection 
and k is a constant for each crystal. These constants range from 6×10-5 for LiF to 
2.2×10-3 for TAP (Reed, 1993). They can cause higher order lines to "cross over" 
and appear on the opposite side of a peak, such as the 3rd order P K upon the F K 
for LDEs. Probe for EPMA automatically uses this precise calculation. 
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Grid 
(Grid File) A file format used by SURFER (Golden Software) to store single 
precision floating point data with 3 coordinates of information (X, Y and Z). The file 
is a binary file and may be read from VB, FORTRAN, C or Pascal. A grid file 
always has the extension ".GRD". The format (v. 6 Surfer) is as follows: 

 
cdum  a 4 byte string containing the characters 'DSBB' (not null 
terminated) 
ixgrid, iygrid two integer*2 values containing the grid density 
xmin, xmax two real*8 values containing the X data minimum and maximum 
ymin, ymax two real*8 values containing the Y data minimum and maximum 
zmin, zmax two real*8 values containing the Z data minimum and maximum 
data  ixgrid * iygrid real*4 values containing the Z data values 
 
The newer grid file format used by Surfer 7 and 8 is also supported by Probe for 
EPMA for output. See the PROBEWIN.INI file parameter 
"SurferOutputVersionNumber" in the [software] section to define the version of the 
GRID file format. 

Hi Peak Counts 
Hi Peak counts are one background (continuum) measurement usually above the 
peak position, although the "high" adjective is strictly relative to the "low peak", so 
in practice could be below the peak position, but higher than the "low peak" position. 

In Probe for EPMA the "high" peak position is always measured first, following the 
on-peak measurement. 

Interference 
An analytical situation when a peak from another element overlaps a primary 
analytical line or background measurement position used in the data acquisition. 
Ignoring this interference will often result in an incorrect analysis. This is sometimes 
seen as a high total when the on-peak interference is large or as a negative raw k-
ratio (KRAW) when the off-peak position is interfered with. However when the 
interfered element is only a minor or trace quantity, even a small interference can 
result in a large error on the interfered element without affecting the overall total 
significantly. These primary line interferences can be completely and quantitatively 
corrected for using Probe for EPMA. Be aware however, that interferences on your 
off-peak positions need to be checked for, before acquiring any off-peak sample 
data, especially for trace and minor element analyses. 

In some cases where one has the choice between use of two diffracting crystals, the 
one with the lowest 2d will provide the maximum spectral resolution available for 
minimizing overlap of peaks. 

Interference Standard 
A standard used for the quantitative interference correction in Probe for EPMA. A 
standard used for the interference correction can also be used for the analytical 
calibration and need only be analyzed once, although additional interference 
standardizations can be used in the automatic drift corrections if they are available 
(this is done automatically if the interference is declared in the Analyze! | Standard 
Assignments). To use the quantitative interference corrections in Probe for EPMA 
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you must acquire counts on both the interfered element (obviously) and the 
interfering element. To use a standard as an interference standard, it must contain a 
known concentration of the interfering element, and it must not contain the 
interfered element, nor can it contain any other elements that interfere with the 
interfered element. You can add additional standards to a Probe for EPMA run using 
the Standard | Add Standards To Run menu. 

K-Factor 
Initial probe work by Castaing was metallurgical and the standards were pure 
elements, and so the K-ratio was defined relative to a pure element standards. In the 
situations where the standard is not the pure element, a means to use the normal form 
K-ratio is to normalize the standard, using the standard k-factor. This is the 
concentration of the element in the standard (as a fraction) divided by the ZAF 
correction of the element in the standard. See also raw k-ratio, unknown k-ratio and 
ZAF. The expression is : 

 

Where: 

: concentration of element A in the standard 

: ZAF correction for element A in the standard 

K-Ratio 
See raw k-ratio, unknown k-ratio, k-factor and ZAF. 

P/B 
Peak to Background Ratio. Strictly the total counts at the peak position (which will 
also include the continuum contribution in addition to the characteristic x-ray 
counts). A measure of the sensitivity of the analysis. To improve your detection 
limit, you will want to increase the peak to background ratio. This can be 
accomplished by using the analyzing crystal with the highest theta available (for 
example run K K� on LiF rather than PET)  by using the highest accelerating 
voltage reasonably feasible, and using lower noise flow detectors rather than sealed 
detectors. The P/B is calculated as : 

 

 
Where: 
IP: background corrected peak intensity 

IB: background continuum intensity 
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PHA 
Pulse Height Analysis (or Analyzer). The x-rays that satisfy Bragg's Law reach the 
detector inside the spectrometer housing, where they ionize the gas (produce 
photoelectrons and Ar cations) and create a small analog electronic signal. This 
signal passes to a pre-amp and then through an electronic circuit that shapes it into a 
digital pulse for input to the x-ray counter scalers. In a properly configured detection 
system, the bias in the detector is set so that the ionization occurs in the "proportional 
range", and higher order (n>1) diffractions that also satisfy Bragg's Law (and are 
discrete fractions of the wavelength of the desired element), will have discrete 
multiples of the pulse energy. Thus, if the first order peak has a peak at 2.0 volts, the 
3rd order peak would have a peak at 6.0 volts.  

This provides one way to reduce or eliminate higher order interferences: setting a 
window so that the desired element's x-rays are passed through, but that the higher 
energy interfering x-rays are rejected. This is known as "differential" mode, whereas 
under "integral" mode there is no window. Also, a lower limit or baseline (e.g. 0.5 
volts) is set to filter low energy electronic noise. Use of differential mode PHA 
should be used with care, as there are possible serious errors that can occur to the 
unwary (see discussion of energy shifts in the manual). Probe for EPMA offers a 
sophisticated interference correction which in many situation eliminates the need to 
use differential mode PHA (which can only reduce higher order interferences in any 
case). 

Pixel 
A single image element. 

Primary standard 
An analytical standard which is assigned as the calibration standard for one or more 
analyzed elements in a quantitative run. Elements in standards not assigned as the 
primary calibration, but which contain an acquired element can be considered 
secondary standards. 

Raw K-Ratio 
A k-ratio is the ratio of unknown intensity relative to a reference intensity. Several 
varieties of these are defined. The raw k-ratio is defined as the ratio of the unknown 
counts to the standard counts for a element. The intensities are usually corrected for 
beam drift, dead time, background and standard drift. See also unknown k-ratio, k-
factor and ZAF. The expression is : 

 

Where : 

: is the unknown intensity for element A at  

: is the standard intensity for element A at 

If the standard were a pure element, then the K(raw) would be a fraction less than or 
equal to 1, and very roughly equivalent to the elemental fraction in the unknown. 
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This approximation has become known as "Castaing's first approximation", after the 
founder of EPMA. 

Secondary Standard 
A standard which is not assigned as a primary standard for a given element  (that is, 
not directly used in the quantitative calculation of unknowns). However, it is useful, 
if the secondary standard contains a known quantity of the analyzed element, to 
check the quality of the secondary analysis can be judged by observing the "%VAR" 
line when an analysis is performed. The "%VAR" is calculated as follows : 

 

Where : 

: is the published concentration of the element 

: is the measured average concentration of the element 

Spectrometer 
A wavelength dispersive spectrometer (WDS) used with electron microprobe 
analyzers (EPMA) to acquire x-ray photons for composition mapping. 

A spectrometer that can be tuned to a range of analytical x-ray lines. Usually 
contains two to four analyzing crystals. Scanning spectrometers are required for off-
peak background corrections. MAN background corrections can be used for either 
fixed or scanning spectrometers. 

TIFF 
(Tagged Image File Format) An image file format consisting of rasterized pixel color 
information. Probe for EPMA can create an OLE script that will automatically create 
.GRD files that can be imported by Probe Image for fully registered TIFF images. 

WDS 
(Wavelength Dispersive Spectrometry) X-ray analysis based on Bragg's law of x-ray 
diffraction. 

 

Where: 

n: order of the x-ray (1st, 2nd, etc.) 
: wavelength in angstroms 
2d: lattice spacing of the analyzing crystal in angstroms 
: angle of diffraction 
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